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GETTING STARTED WITH ARCGIS PRO 

Trainer 1: Tendai Dupwa  

Trainer 2: Joshua Manamela 

 

Overview: 

This comprehensive guide will empower you to navigate ArcGIS Pro proficiently while honing the core 

principles of GIS. Through engaged practice, you will delve into data management, map creation, 

geoprocessing, editing, and spatial analysis.  It is your gateway to mastering the world of ArcGIS Pro. 

 

Section 1: Exploring Data in ArcGIS Pro 

Exploring Data in ArcGIS Pro allows you to uncover hidden insights and patterns within your geographic 

information. Discover the power of visualizing and analyzing data to make informed decisions and gain 

valuable insights in your GIS projects. 

1.1. Explore the ArcGIS Pro Interface.  

a. Launch ArcGIS Pro on your computer. 

b. Click “Open another project”, browse to C:\Student\TRAINING SESSION 3\Getting Started 

with ArcGIS Pro and double-click Getting Started.aprx to open the project.  

 
 

c. Click each tab at the top of the map view area to explore ArcGIS Pro functionality.  

d. Explore the Catalog pane to see the contents of the project. 

e. Open the “Exploring Data” Map if necessary and zoom in to have a sense of the area you 

will be working with. Notice the layers in the Contents Pane.  
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1.2. Access and Import Water Point Location from a CSV file. 

f. From the Catalog Pane, expand Folders > Data and locate WaterPoints.csv. 

 

g. Right-click the WaterPoints.csv and select “Add To Current Map”. 

h. In the Contents Pane right-click the WaterPoints.csv table and “Open”. 

  

i. Explore the table and take notes of the fields that can be used to display the data on the 

map.  

j. Right-click the WaterPoints.csv and select “Display XY Data” from the context menu. 

k. In the "Display XY Data" dialog appears: 
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l. Match the parameters to the image above and click Ok. 

Your points are added to the contents, and you now can modify the layer's symbology and access 

the functionality of the feature class. You have the option to right-click on the Waterpoints layer 

after it has been added to the contents, and by selecting "Zoom to Layer," you can focus on the 

added features. 

1.3. Explore the File Geodatabase and Portal Items 

a. In the Catalog pane, you will see the "Getting Started" geodatabase.  

b. Click on it to expand its contents. 

c. You will see a list of feature datasets, feature classes, and other datasets within the "Getting 

Started" geodatabase. 

d. Expand the “Water_network” feature dataset and notice the Geodatabase Topology within 

the feature dataset.  

e. Right click on the file geodatabase and select Add to Favorites.  

 

 

 You can also explore and use authoritative data from your ArcGIS Enterprise or ArcGIS online 

with ArcGIS pro.  

f. In the Catalog Pane click Portal and select ArcGIS Enterprise. In the search bar Type 

“Mbombela”  

 
g. Right Click on the Mbombela feature layer and select Add to Current Map.  

You have the option to right-click on the layer after it has been added to the contents, and by 

selecting "Zoom to Layer," you can focus on the added features. ArcGIS Pro also provides the 

capability to establish a connection to your ArcGIS Enterprise or ArcGIS Online, enabling you 

to access a broader range of data sources.   
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Section 2: Visualize Data to Solve spatial Problems.  

As we delve into data visualization within ArcGIS Pro, you will discover the power of visualization techniques 

for spatial problem-solving. Visualization in ArcGIS Pro serves as a vital tool for both preparing your data 

for analysis and effectively conveying information to your intended audience. In this section, we will focus 

on crafting thematic maps specifically designed to pinpoint regions and demographics that could potentially 

face issues related to water scarcity. 

 

2.1. Symbolize the Water Point layer.  

In this step, we will improve the visual representation of the water points layer by importing symbology 

from an existing layer file. 

a. Make sure that the visualization map containing the water point symbols is already open 

within your project. 

b. Under the Map tab select the Ehlanzeni District Bookmark. 

c. In the "Contents" pane, find and select your Water Point layer within the open Visualization 

map. 

 
 

d. Choose the "Symbology" tab within the "Feature Layer" section on the ribbon. 

 

 
e. In the Symbology pane, locate the "Import symbology" button or option. 

 

 
 

f. In the “Apply Symbology From Layer” geoprocessing tool that opens: 

• Input layer: Water Points 
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• Symbology Layer: \\Folders\Getting Started\Data\Water_Points.lyrx  

• Type: Value field 

• Source Field: SEGD_S_DES 

• Target Field: SEGD_S_DES 

 

g. Click “Run”. 

h. In the Symbology pane, you will see the imported symbology from the layer file. 

i. To change the scaling of point symbols, click on the "Symbol" for your water points layer. 

j. On the feature layer tab, change the “Out Beyond” Visibility Range to 1:80 000. 

h. Zoom into a scale beyond 1:80 000 to see the effect of the scale range.  

2.2. Symbolize Water Sources 

In this step, we will enhance the visual depiction of the Water Source layer by using symbology designed 

to highlight the primary water source and its potential connection to Community Needs..  

a. In the contents expand the “Needs & Water” and select the Water Sources layer and access 

the symbology pane.  

b. In the symbology pane, change the primary symbology to Bivariate Colors and change the 

parameters to feature the following:  

c.  Click the Legend tab in the symbology pane and match your labels with the following:  

 

 
 

 

d. Test the visuals by zooming in and out. Pay close attention to regions that heavily rely on 

boreholes and water tanks. When you enable clusters and the Community Needs layer, you 

will observe an overlay between areas with specific water needs and the relevant water 

sources.  
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2.3. Visualize data with charts. 

In this step, you will use charts to visualize your data. Charts in ArcGIS Pro provide an additional layer of 

insight, allowing you to highlight patterns and details that might not be immediately evident on the map.  

a. Right-click the water sources layer and navigate to “Create Charts” and select “Pie Chart”. 

b. In the Chart Properties Pane match the following: 

 

 

c. Click on the general tab in the Chart Properties pane and change the Chart title to “Water 

Sources.”  

 

 
 

The pie chart displays the distribution of water sources along with their respective percentages. This 

visualization assists in pinpointing the predominant water sources in specific areas. Additionally, 

these charts offer interactivity with the map, enabling selections and a deeper exploration of the 

data. 
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Section 3: Understanding Edit Techniques in ArcGIS Pro 

ArcGIS Pro's editing capabilities are versatile, catering to a wide range of workflows, spanning from 

general mapping applications to industry-specific sectors such as utilities, land records, natural resources, 

and facilities management. You have the flexibility to edit data from various sources, whether in 2D or 3D, 

all within the ArcGIS Pro environment. 

3.1. Prepare Editing Environment  

Prior to editing a feature layer, it is important to review various maps, layers, and editing settings that 

can significantly improve your editing process. In this step, you will delve into editing settings and 

functions that enhance the overall editing experience, making it more efficient and successful. 

a. Ensure that the “Editing” map is active and click on the “Edit” tab in the top menu to access 

editing tools.  

 

 

b. On the Edit tab under Manage Edits click “Settings” and explore the different settings.  

By configuring constraints, enabling snapping, and making use of inferences, you will enhance the 

precision and efficiency of your editing tasks within ArcGIS Pro. 

c. Click “OK” to close the Editor Settings.  

3.2. Explore and Prepare Feature Templates 

ArcGIS Pro provides the capability to utilize feature templates, which consist of a collection of construction 

tools tailored to your institutional workflows. Continuing with the water resource management scenario, 

you will now expand a water network within a specific area of interest as part of a municipal water 

management scheme. 

a. From the map tab, zoom to the “Tsitsa street” bookmark. 

The map shows a segment of a water service line that is being captured as part of the municipality's 

water management scheme.  
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b. On the Edit tab, in the feature group, click “Create” to open the “Create Feature” pane.  

c. Before selecting a feature template, zoom into Tsitsa street.  

d. In the Create Features pane right-click the “Distribution main Water Services” and click 

properties. 

e. In the template properties, opt for "Builders" to gain access to builders that offer extra features 

and capabilities.  

f. If required, modify the second feature from “Tee” to “Service”.  

Steps d to f have been illustrated below: 

 

g. Click Apply and Ok to confirm the changes. 

3.3. Use a feature template to create new geometry.  

Now that your feature templates are ready, you can create your new features. 

a. From the map tab, zoom to the “Tsitsa street” bookmark. 

The map shows a segment of a water service line that is being captured as part of the municipality's 

water management scheme.  

b. In the Create Features pane, select Distribution main Water Services. 

c. On the map, click the end of the existing main and add vertices at every house shown on the 

image. Follow the illustration below for guidance.  
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d. To finish your sketch, double click the last vertex that you added, press the F2 key or click the 

finish button. 

The finished sketch appears with a cyan outline to indicate that it is selected.  

3.4. Use a feature template to create new geometry (Optional)  

Additionally, you have the option to include residential connections using an existing group template. The 

Residential Service Template consists of a Residential connection valve and a service line that branches 

off from the service valves added to your main network.  

a. In the Create Features pane select the Residential connection template under the water main.  

 

b.  On your map, select a service valve as your initial vertex and then add the final vertex within a 

residential boundary.  
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c. You have the flexibility to incorporate additional residential service connections along the street.  

This editing workflow can be seamlessly integrated with topology to guarantee that your edits 

adhere to the defined rules consistently. 
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Section 4: Create Map Layouts. 

Even in the era of smart maps, the significance of a printed map as a means of effectively conveying 

information remains evident. In ArcGIS Pro, you have the flexibility to include traditional map elements 

and customize their properties on the page. Notably, you can introduce multiple layouts to your project, a 

feature not supported in ArcMap, further enhancing the versatility of your map design and presentation 

capabilities.  

4.1. Prepare the map page. 

ArcGIS Pro empowers you to develop organizational layout templates that can be stored within your 

ArcGIS Enterprise environment. In this step, you will retrieve the template directly from your ArcGIS 

Enterprise. 

a. Ensure that you are signed into the ArcGIS Enterprise portal.  

b. In the Catalog Pane select “Portal” and search for:” Service Management”.  

 

 
c. Right-click the Service Management layout file and select “Add and Open.’’  

 

d. Double click the Map Frame in the center of the template to add a map.  

e. In the Element Pane which appears, the map changes to visualization.  

 

1 

2 
3 
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f. Notice that Your map elements are updated.  

g. If you are unable to see your mapped out area, expand the Map Frame in the contents pane, 

right-click the “Water Sources” layer and zoom to layer.  

4.2. Modify Map Layout Elements.  

You will proceed to adjust the surrounding map elements, which have been dynamically updated. 

a. In the Contents, expand the Legend Element and unselect the layers you do not want to see in your 

legend. 

b. Right-click the Legend Element in the contents and select properties.  

c. Within the Legend Element pane, choose "Legend Arrangement Options," and modify the Fitting 

Strategy to "Adjust Column.".  

d. You can now adjust the legend to fit within the allocated frame.  

e. Navigate to the "Insert" tab on the ribbon, and under "Map Surrounds," select "Chart Frame.  

f. Pick the "Water Sources" pie chart that you previously generated and place it inside the Map Extent 

Frame.  

g. In the Chart Frame element pane uncheck “Only show chart data visible in the map frame”.  

 

h. Notice that the pie chart is added to the map layout.  

2 
1 
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Now, feel free to explore the properties of other elements as needed. You can also reposition 

elements according to your audience's requirements and your organization's standards. These 

layouts are versatile and can be exported to various formats to suit your specific needs.  
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Esri resources 

 

Take advantage of these resources to develop ArcGIS software skills, discover applications of geospatial 

technology, and tap into the experience and knowledge of the ArcGIS community. 

 

Instructor-led and e-Learning resources  

Esri instructor-led courses and e-Learning resources help you develop and apply ArcGIS skills, 

recommended workflows, and best practices. View all training options at esri.com/training/ 

catalog/search. 

 

GIS bibliography  

A comprehensive index of journals, conference proceedings, books, and reports related to GIS, 

including references and full-text materials. gis.library.esri.com  

 

ArcGIS documentation and tutorials  

In-depth information, tutorials, and documentation for ArcGIS products.  

ArcGIS Online: arcgis.com  

ArcGIS Desktop: desktop.arcgis.com  

ArcGIS Enterprise: enterprise.arcgis.com  

 

GeoNet 

 Join the online community of GIS users and experts. community.esri.com  

 

Esri events  

Esri conferences and user group meetings offer a great way to network and learn how to achieve results 

with ArcGIS. esri.com/events 

  

Esri Videos  

View an extensive collection of videos by Esri leaders, event keynote speakers, and product experts. 

youtube.com/user/esrit 


